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1 INTRODUCTION

1.1 CAUTIONS

Caution
The GPS system is operated by the government of the United States, which is solely responsible for its
accuracy and maintenance. Although the GPS 15H & 15L is a precision electronic NAVigation AID
(NAVAID), any NAVAID can be misused or misinterpreted, and therefore become unsafe. Use these
products at your own risk. To reduce the risk, carefully review and understand all aspects of these
Technical Specifications before using the GPS 15H & 15L. When in actual use, carefully compare
indications from the GPS to all available navigation sources including the information from other
NAVAIDs, visual sightings, charts, etc. For safety, always resolve any discrepancies before continuing
navigation.

FCC
Compliance

The GPS 15H & 15L complies with Part 15 of the FCC interference limits for Class B digital devices FOR
HOME OR OFFICE USE. These limits are designed to provide reasonable protection against harmful
interference in a residential installation, and are more stringent than “outdoor” requirements.

Operation of this device is subject to the following conditions: (1) This device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there
is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following measures:

•  Reorient or relocate the receiving antenna.

•  Increase the separation between the equipment and receiver.

•  Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

•  Consult the dealer or an experienced radio/TV technician for help.

The GPS 15H & 15L does not contain any user-serviceable parts. Unauthorized repairs or modifications
could result in permanent damage to the equipment, and void your warranty and your authority to operate
this device under Part 15 regulations.
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1.2 LIMITED WARRANTY
This Garmin product is warranted to be free from defects in materials or workmanship for one year from
the date of purchase. Within this period, Garmin will at its sole option, repair or replace any components
that fail in normal use. Such repairs or replacement will be made at no charge to the customer for parts or
labor, provided that the customer shall be responsible for any transportation cost. This warranty does not
cover failures due to abuse, misuse, accident, or unauthorized alteration or repairs.

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF
ALL OTHER WARRANTIES EXPRESS OR IMPLIED OR STATUTORY, INCLUDING ANY
LIABILITY ARISING UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, STATUTORY OR OTHERWISE. THIS WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS, WHICH MAY VARY FROM STATE TO STATE.

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR
CONSEQUENTIAL DAMAGES, WHETHER RESULTING FROM THE USE, MISUSE, OR
INABILITY TO USE THIS PRODUCT OR FROM DEFECTS IN THE PRODUCT. Some states do not
allow the exclusion of incidental or consequential damages, so the above limitations may not apply to you.

Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund of the
purchase price at its sole discretion. SUCH REMEDY SHALL BE YOUR SOLE AND EXCLUSIVE
REMEDY FOR ANY BREACH OF WARRANTY.

To obtain warranty service, contact your local Garmin authorized dealer; or call Garmin Customer Service
at one of the numbers shown below, for shipping instructions and an RMA tracking number. The unit
should be securely packed with the tracking number clearly written on the outside of the package. The unit
should then be sent, freight charges prepaid, to any Garmin warranty service station. A copy of the original
sales receipt is required as the proof of purchase for warranty repairs.

Garmin International, Inc.
1200 East 151st Street
Olathe, KS  66062 U.S.A.
Telephone: 913/397.8200
FAX: 913/397.8282

Garmin (Europe) Ltd.
Unit 5, The Quadrangle, Abbey Park Industrial Estate
Romsey SO51 9DL, U.K.
Telephone: 44/0870.8501241
FAX: 44/0870.8501251
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1.3 OVERVIEW
The GPS 15H & 15L are part of Garmin’s latest generation of GPS sensor boards designed for a broad
spectrum of OEM (Original Equipment Manufacture) system applications. Based on the proven technology
found in other Garmin 12-channel GPS receivers, the GPS 15H & 15L track up to 12 satellites at a time
while providing fast time-to-first-fix, one-second navigation updates and low power consumption. The GPS
15H & 15L also provide the capability of FAA Wide Area Augmentation System (WAAS) differential
GPS. Their far-reaching capabilities meet the sensitivity requirements of land navigation, the timing
requirements for precision timing applications, as well as the dynamics requirements of high-performance
aircraft.

The GPS 15H & 15L designs utilize the latest technology and high-level circuit integration to achieve
superior performance while minimizing space and power requirements. All critical components of the
system including the RF/IF receiver hardware and the digital baseband are designed and manufactured by
Garmin to ensure the quality and capability of the GPS. The hardware capability combined with software
intelligence makes the GPS 15H & 15L easy to integrate and use.

Being complete GPS receivers, the GPS 15H & 15L require minimal additional components to be supplied
by an OEM or system integrator. A minimum system must provide the GPS with a source of power, an
active GPS antenna, and a clear view of the GPS satellites. The system may communicate with the GPS
15H & 15L via two RS-232 compatible receive channels and one transmit channel. The GPS 15H & 15L
internal FLASH memory allows the GPS to retain critical data such as satellite orbital parameters, last-
known position, date and time. End user interfaces such as keyboards and displays are the responsibility of
the application designer.

1.4 FEATURES
•  12-channel GPS receiver tracks and uses up to 12 satellites for fast, accurate positioning, and low

power consumption.

•  Differential DGPS capability utilizing real-time WAAS or RTCM corrections yielding 3–5 meter
position accuracy (see Section 1.5.4.4).

•  Compact, rugged design ideal for applications with minimal space.

•  May be remotely mounted in an out-of-the-way location.

•  Receiver status information can be displayed directly on a chartplotter or PC.

•  User initialization is not required. Once installed and a fix is obtained, the unit automatically
produces navigation data.

•  User-configurable navigation mode (2-dimensional or 3-dimensional fix).

•  Highly accurate one-pulse-per-second (PPS) output for precise timing measurements. Pulse width
is configurable in 20 millisecond increments from 20 ms to 980 ms.

•  Configurable for binary format carrier phase data output on COM 1 port.

•  Flexible input voltage levels of 3.3 to 5.4 VDC (GPS 15L) or 8.0 to 40 VDC (GPS 15H).

•  Built-in backup battery to maintain real-time clock for up to 21 days. Provision for external power
to maintain the real-time clock for longer intervals.

•  FLASH-based program and non-volatile memory. New software revisions upgradeable through
web site download and serial interface. Non-volatile memory does not require battery backup.
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1.5 TECHNICAL SPECIFICATIONS
Specifications are subject to change without notice.

1.5.1 Physical Characteristics

1.5.1.1 Size
1.400” (35.56 mm) wide x 1.805” (45.85 mm) long x 0.327” (8.31 mm) high

1.5.1.2 Weight
•  GPS 15H: 0.53 oz. (15.0 g)

•  GPS 15L: 0.50 oz (14.1 g)

1.5.1.3 Available Connector Options
•  GPS 15H-F & 15L-F: 8-pin LIF (Low Insertion Force) flex connector, 1-millimeter pitch. For use

with common 1mm pitch, 8-conductor flex cable, available as Garmin Part
Number 310-00040-01. This flex cable mates with common 1mm pitch, 8-
pin flex connectors, such as Garmin Part Number 330-00346-08 or Molex
Part Number 52793-0890. Refer to the Molex web site at www.molex.com.

•  GPS 15H & 15L-W: 8-pin JST connector, 1-millimeter pitch. Mating wire harness included
(Garmin Part Number 325-00118-01). The connector housing used on this
harness is equivalent to JST Part Number SHR-08V-S-B. The 8-wire crimp
socket is equivalent to JST Part Number SSH-003T-P0.2. Refer the JST
web site at www.jst.com.

1.5.1.4 Antenna Connector
The GPS 15H & 15L provides a MCX female connector for connection to an active GPS antenna, so the
antenna’s cable should be terminated in MCX male. A suitable antenna is Garmin’s GA 27C Antenna
(Garmin Part Number 010-10052-05). Other antennas that are terminated in male BNC connectors may be
adapted via a Garmin MCX to BNC Adapter Cable is used (Garmin Part Number 010-10121-00).

1.5.2 Electrical Characteristics

1.5.2.1 Input Voltage
•  GPS 15H: 8.0 VDC to 40 VDC unregulated (less than the 100mV peak-to-peak ripple)

•  GPS15L: 3.3 VDC to 5.4 VDC (±100mV)

1.5.2.2 Input Current
•  GPS 15H: 60mA peak, 50mA nominal @ 8.0 VDC

40mA peak, 33mA nominal @ 12 VDC
15mA peak, 12mA nominal @ 40 VDC

•  GPS 15L: 100mA peak, 85mA nominal @ 3.3 to 5.0 VDC

1.5.2.3 GPS Receiver Sensitivity
-165 dBW minimum

1.5.3 Environmental Characteristics
•  Operating Temperature: -30°C to +80°C

•  Storage Temperature: -40°C to +90°C

http://www.molex.com/
http://www.jst.com/
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1.5.4 GPS Performance

1.5.4.1 Receiver
WAAS Enabled™. 12 parallel channel GPS receiver continuously tracks and uses up to 12 satellites (up to
11 with PPS active) to compute and update your position.

1.5.4.2 Acquisition Times
•  Reacquisition: Less than 2 seconds

•  Warm: Approx. 15 seconds (all data known)

•  Cold: Approx. 45 seconds (initial position, time, and almanac known; ephemeris unknown)

•  AutoLocate™: 5 minutes (almanac known; initial position and time unknown)

•  SkySearch: 5 minutes (no data known)

1.5.4.3 Update Rate
1 second default; NMEA 0183 output interval configurable from 1 to 900 seconds in 1-second increments

1.5.4.4 Accuracy
•  GPS Standard Positioning Service (SPS)

Position:< 15 meters, 95% typical
Velocity: 0.1 knot RMS steady state

•  DGPS (USCG/RTCM)
Position:3-5 meters, 95% typical
Velocity: 0.1 knot RMS steady state

•  DGPS (WAAS)
Position:< 3 meters, 95% typical
Velocity: 0.1 knot RMS steady state

•  PPS Time: ±1 microsecond at rising edge of PPS pulse (subject to Selective Availability)

•  Dynamics: 999 knots velocity (only limited at altitude greater than 60,000 feet), 6g dynamics
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1.5.5 Interfaces

1.5.5.1 GPS 15H & 15L Electrical Characteristics
•  True RS-232 output (Port 2 output not used at time of publication), asynchronous serial input

compatible with RS-232 or TTL voltage levels, RS-232 polarity.

•  User selectable NMEA 0183 baud rate (300, 600, 1200, 2400, 4800, 9600, 19200, 38400). Factory
setting is 4800 baud.

1.5.5.2 Port 1 Protocols
•  Configurable between NMEA 0183 Versions 2.00 and 3.00.

•  ASCII output sentences: GPALM, GPGGA, GPGLL, GPGSA, GPGSV, GPRMC, and GPVTG
(NMEA-approved sentences); and PGRMB, PGRME, PGRMF, PGRMM, PGRMT, and PGRMV
(Garmin proprietary sentences).

•  NMEA 0183 Outputs (see Section 4.2 for full protocol specifications)
Position, velocity and time
Receiver and satellite status
Differential Reference Station ID and RTCM Data age
Geometry and error estimates

•  NMEA 0183 Inputs (see Section 4.1 for full protocol specifications)
Initial position, date and time (not required)
Earth datum and differential mode configuration command, PPS Enable, GPS satellite almanac

•  Configurable for binary data output including GPS carrier phase data

1.5.5.3 Port 2 Protocols
Real-time Differential Correction input (RTCM SC-104 message types 1, 2, 3, 7, and 9)

1.5.5.4 PPS
1 Hz pulse, programmable width, 1 µs accuracy

1.5.6 Antenna Specifications
Should be an active antenna with the following specifications:
Gain: Antenna should provide between 10 dB to 30 dB net gain between the

antenna feed point and the connection to the GPS15H & 15L. Consider all
amplifier gains, filter losses, cable losses, etc. when calculating the gain.

RF Connection: GPS 15H & 15L RF Connection: MCX Female connector (on the GPS
15H & 15L board).
Antenna Connection: MCX Male connector (on the end of the antenna
cable).

Garmin Antenna: GPS 27C (Garmin Part Number 010-10052-05) provides the required
MCX Male connector. Other Garmin antennas terminated in a BNC Male
connector may also be used if a Garmin MCX to BNC Adapter Cable
(Garmin Part Number 010-10121-00) is used. Place the MCX to BNC
Adapter Cable between the connector on the end of the antenna cable and
the connector on the GPS 15H & 15L.
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Noise Figure/Gain: The total noise on the external antenna must be ≤ 7dB with a gain between
10 dB and 40 dB. Refer to the table below.

Table 1: Gain vs. SNR for Given Noise Figure

Properly bias the antenna from an on-board source or an external source:
Bias voltage from on-board source: GPS 15H supplies 3.3 VDC to the center conductor of the MCX

female, relative to the connector shell ground.
GPS 15L supplies 3.0 VDC to the center conductor of the MCX
female, relative to the connector shell ground
In both the GPS 15H and 15L, the source resistance of the DC supply
to the center conductor of the connector is approximately 10 Ohms,
which is included as a current limiting resistance. This resistance
allows the receiver to survive momentary shorting of the antenna port.
There is no provision to protect against a continuously shorted antenna
port.
The antenna must not draw more than 60mA.

Bias voltage from external source: 4.0 to 8.0 VDC bias through the series combination of an on-board
~10 Ohm current limiting resistance and a Schottky diode.
The antenna must not draw more than 60mA.

10.0

11.0

12.0

13.0

14.0

15.0

16.0

17.0

18.0
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2 GPS 15H & 15L WIRE DESCRIPTIONS AND WIRING DIAGRAMS

The GPS 15H-F & 15L-F use an eight-contact flex circuit LIF (low insertion force) connector. The GPS
15H-W & 15L-W use an eight-pin JST connector (mating wire harness included). See Section 1.5.1.3.

2.1 GPS 15H & 15L WIRE DESCRIPTIONS
Pin # Signal Name Description

1 BACKUP
POWER

This input provides external power to maintain the real-time clock. This enables
the user to provide backup power if needed for longer than the on-board backup
battery provides (roughly 21 days). Input voltage must be between +2.8 and +3.4
VDC.

2 GROUND Power and Signal Ground
3 POWER GPS 15L: +3.3 to +5.4 VDC (±100 mV) input. Peak operating current is 100mA.

Nominal operating current is 85mA. This voltage drives an LDO with a nominal
3.0 VDC output.
GPS 15H: Unregulated 8.0 to 40 VDC input. Peak operating current is 40mA @
12 VDC input. Nominal operating current is 33mA @ 12 VDC input. This voltage
drives a switching regulator with a nominal 3.3 VDC output. Although a regulated
supply is not required, the peak-to-peak voltage ripple on this line should be kept
to less than 100 mV.

4 PORT 1
DATA OUT

Serial Asynchronous Output
RS-232 compatible output normally provides serial data which is formatted per
“NMEA 0183, Version 2.0”. This output is also capable of outputting phase data
information, see Appendix B: Binary Phase Output Format for details. The
NMEA 0183 baud rate is selectable in the range of 300 to 38400 baud. The default
baud rate is 4800.

5 PORT 1
DATA IN

First Serial Asynchronous Input
RS-232 compatible with maximum input voltage range of -25 < V < 25. This
input may also be directly connected to standard 3 to 5 VDC CMOS logic that
utilizes RS-232 polarity. The low signal voltage requirement is < 0.6 V, and the
high signal voltage requirement is > 2.4 V. Minimum load impedance is 500 Ω.
This input may be used to receive serial initialization/ configuration data as
specified in Section 4.1 Received NMEA 0183 Sentences.

6 RF BIAS This input allows the user to supply an external RF bias voltage in the range of 4
VDC to 8 VDC to the active antenna. The voltage should be from a clean,
regulated supply and should be well isolated from potential sources of
interference. The supply should not share RF current paths with other system
devices such as microprocessors or other RF circuits. By default, the unit uses an
internal voltage to power the active antenna.

Note: This pin is only operational on units whose serial numbers are higher than
the serial numbers given below:
010-00240-01 GPS 15H-W serial no. 81301857
010-00240-02 GPS 15L-W serial no. 81408976
010-00240-11 GPS 15H-F serial no. 81901632
010-00240-12 GPS 15L-F serial no. 82001471

7 PPS One-Pulse-Per-Second Output
Typical voltage rise and fall times are 100 ns. Impedance is 250 Ω. The open
circuit output voltage toggles between the low (0 V) and the high (3.3 V for 15H
and 3.0 V for 15L). The default format is a 100 ms wide active-high pulse at a
1 Hz rate, with the pulse width configurable in 20 ms increments. Rising edge is
synchronized to the start of each GPS second. This output provides a nominal 450
mVp-p signal into a 50 Ω load. The pulse time measured at the 50% voltage point
will be approximately 15 ns earlier with a 50 Ω load than with no load.

8 PORT 2
DATA IN

Second Serial Asynchronous Input
This input may be used to receive serial differential GPS data formatted per
“RTCM SC-104 Recommended Standards For Differential Navstar GPS Service,
Version 2.2” (see Section 4.5 for more details).

Table 2: GPS 15H & 15L Wire Descriptions
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2.2 GPS 15H & 15L WIRING DIAGRAMS

Figure 1: Computer Serial Port Interconnection

Figure 2: PDA Serial Port Interconnection

Figure 3: Basic NMEA Device Interconnection
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3 MECHANICAL CHARACTERISTICS & MOUNTING

Figure 4: GPS 15H-F & 15L-F Dimensions

Figure 5: GPS 15H-W & 15L-W Outline Drawing
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4 GPS 15H & 15L SOFTWARE INTERFACE

The GPS 15H & 15L interface protocol design on COM 1 is based on the National Marine Electronics
Association’s NMEA 0183 ASCII interface specification. The COM 2 port can receive differential GPS
(DGPS) correction data using the Radio Technical Commission for Maritime Services’ RTCM SC-104
standard. These standards are fully defined in “NMEA 0183, Version 3.0” (copies may be obtained from
NMEA, www.nmea.org) and “RTCM Recommended Standards For Differential Navstar GPS Service,
Version 2.2, RTCM Special Committee No. 104” (copies may be obtained from RTCM, www.rtcm.org).

The GPS 15H & 15L interface protocol, in addition to transmitting navigation information as defined by
NMEA 0183, transmits additional information using the convention of Garmin proprietary sentences.
These proprietary sentences begin with the characters, “$PGRM”, instead of the characters “$G” that are
typical of the standard NMEA 0183 sentences. The characters “$P” indicate that the sentence is a
proprietary implementation and the characters and “GRM” indicate that it is Garmin’s proprietary sentence.
The letter (or letters) that follow the characters “$PGRM” uniquely identifies that particular Garmin
proprietary sentence.

Binary phase data information can alternatively be output on the COM 1 port; see Appendix B: Binary
Phase Output Format for details.

The following sections describe the NMEA 0183 data format of each sentence transmitted and received by
the GPS 15H & 15L.

4.1 RECEIVED NMEA 0183 SENTENCES
The following paragraphs define the sentences that can be received on the GPS sensors’ port. Null fields in
the configuration sentence indicate no change in the particular configuration parameter. All sentences
received by the GPS sensor must be terminated with <CR><LF>, the ASCII characters for carriage return
(0D hexadecimal) and line feed (0A hexadecimal), respectively. The checksum *hh is used for parity
checking data and is recommended for use in environments containing high electromagnetic noise. It is
generally not required in normal PC environments. When used, the parity bytes (hh) are the ASCII
representation of the upper and lower nibbles of the exclusive-or (XOR) sum of all the characters between
the “$” and “*” characters, non-inclusive. The hex representation must be a capital letter, such as 3D
instead of 3d. Sentences may be truncated by <CR><LF> after any data field and valid fields up to that
point will be acted on by the sensor.

4.1.1 Almanac Information (ALM)
The $GPALM sentence can be used to initialize the GPS sensor’s stored almanac information in the
unlikely event of non-volatile memory loss, or after storage of greater than six months without tracking
GPS satellites.

$GPALM,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF>

<1> Total number of ALM sentences to be transmitted by the GPS sensor during almanac
download. This field can be null or any number when sending almanac to the GPS sensor.

<2> Number of current ALM sentence. This field can be null or any number when sending
almanac to the GPS sensor.

<3> Satellite PRN number, 01 to 32
<4> GPS week number
<5> SV health, bits 17-24 of each almanac page
<6> Eccentricity
<7> Almanac reference time
<8> Inclination angle
<9> Rate of right ascension

<10> Root of semi major axis
<11> Omega, argument of perigee
<12> Longitude of ascension node
<13> Mean anomaly
<14> af0 clock parameter
<15> af1 clock parameter

http://www.nmea.org)/
http://www.rtcm.org/
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4.1.2 Sensor Initialization Information (PGRMI)
The $PGRMI sentence provides information used to initialize the GPS sensor’s set position and time used
for satellite acquisition. Receipt of this sentence by the GPS sensor causes the software to restart the
satellite acquisition process. If there are no errors in the sentence, it is echoed upon receipt. If an error is
detected, the echoed PGRMI sentence will contain the current default values. Current PGRMI defaults
(with the exception of the Receiver Command, which is a command rather than a mode) can also be
obtained by sending $PGRMIE to the GPS sensor.

$PGRMI,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF>

<1> Latitude, ddmm.mmm format (leading zeros must be transmitted)
<2> Latitude hemisphere, N or S
<3> Longitude, dddmm.mmm format (leading zeros must be transmitted)
<4> Longitude hemisphere, E or W
<5> Current UTC date, ddmmyy format
<6> Current UTC time, hhmmss format
<7> Receiver Command, A = Auto Locate, R = Unit Reset

4.1.3 Sensor Configuration Information (PGRMC)
The $PGRMC sentence provides information used to configure the GPS sensor’s operation. Configuration
parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor echoes
this sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMC sentence
will contain the current default values. Current default values can also be obtained by sending $PGRMCE
to the GPS sensor.

$PGRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>*hh<CR><LF>

<1> Fix mode, A = automatic, 2 = 2D exclusively (host system must supply altitude),
3 = 3D exclusively

<2> Altitude above/below mean sea level, -15H & 15L00.0 to 18000.0 meters
<3> Earth datum index. If the user datum index (96) is specified, fields <4> through <8> must

contain valid values. Otherwise, fields <4> through <8> must be null. Refer to Appendix A:
Earth Datums for a list of earth datums and the corresponding earth datum index.

<4> User earth datum semi-major axis, 6360000.000 to 6380000.000 meters (.001 meters
resolution)

<5> User earth datum inverse flattening factor, 285.0 to 310.0 (10-9 resolution)
<6> User earth datum delta x earth centered coordinate, -5000.0 to 5000.0 meters (1 meter

resolution)
<7> User earth datum delta y earth centered coordinate, -5000.0 to 5000.0 meters (1 meter

resolution)
<8> User earth datum delta z earth centered coordinate, -5000.0 to 5000.0 meters (1 meter

resolution)
<9> Differential mode, A = automatic (output DGPS data when available, non-DGPS otherwise), D

= differential exclusively (output only differential fixes)
<10> NMEA 0183 Baud rate, 1 = 1200, 2 = 2400, 3 = 4800, 4 = 9600, 5 = 19200, 6 = 300, 7 = 600,

8 = 38400
<11> Velocity filter, 0 = No filter, 1 = Automatic filter, 2-255 = Filter time constant (e.g., 10 = 10

second filter)
<12> PPS mode, 1 = No PPS, 2 = 1 Hz
<13> PPS pulse length, 0-48 = (n+1)*20 ms.  Example: n = 4 corresponds to a 100 ms wide pulse
<14> Dead reckoning valid time 1-30 (sec)

All configuration changes take effect after receipt of a valid value except baud rate and PPS mode. Baud
rate and PPS mode changes take effect on the next power cycle or an external reset event.
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4.1.4 Additional Sensor Configuration Information (PGRMC1)
The $PGRMC1 sentence provides additional information used to configure the GPS sensor operation.
Configuration parameters are stored in non-volatile memory and retained between power cycles. The GPS
sensor echoes this sentence upon its receipt if no errors are detected. If an error is detected, the echoed
PGRMC1 sentence will contain the current default values. Current default values can also be obtained by
sending $PGRMC1E to the GPS sensor.

$PGRMC1,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>*hh<CR><LF>

<1> NMEA 0183 output time 1-900 (sec)
<2> Binary Phase Output Data, 1 = Off, 2 = On
<3> Automatic Position Averaging when Stopped, 1 = Off, 2 = On
<4> DGPS beacon frequency – 0.0, 283.5 – 325.0 kHz in 0.5 kHz steps
<5> DGPS beacon bit rate – 0, 25, 50, 100, or 200 bps
<6> DGPS beacon scanning, 1 = Off, 2 = On
<7> NMEA 0183 version 3.00 mode indicator, 1 = Off, 2 = On
<8> DGPS mode, A = Automatic, W = WAAS Only, R = RTCM Only, N = None (DGPS

disabled)
<9> Power Save Mode, P = Power Save mode, N = Normal

At power up or external reset, a stored beacon frequency other than 0.0 causes the GPS sensor to tune the
beacon receiver. Configuration changes take effect immediately, with the exception of Binary Phase Output
Data, which takes effect on the next power cycle or a reset event. A reset can be commanded by sending
the sentence “$PGRMI,,,,,,,R” (refer to Section 4.1.2).

If the GPS sensor is in the Binary data mode, it is necessary to send the following eight-byte data stream to
the COM 1 input to temporarily change the data format to NMEA 0183. Then send a PGRMC1 sentence
that turns off the Binary Phase Output Data format:

10 0A 02 26 00 CE 10 03 (Hexadecimal)

4.1.5 Output Sentence Enable/Disable (PGRMO)
The $PGRMO sentence provides the ability to enable and disable specific output sentences. The following
sentences are enabled at the factory: GPGGA, GPGSA, GPGSV, GPRMC, PGRMB, PGRME, PGRMM,
PGRMT, and PSLIB.

$PGRMO,<1>,<2>*hh<CR><LF>

<1> Target sentence description (e.g., PGRMT, GPGSV, etc.)
<2> Target sentence mode, where:

0 = disable specified sentence
1 = enable specified sentence
2 = disable all output sentences (except PSLIB)
3 = enable all output sentences (except GPALM)
4 = restore factory default output sentences

The following notes apply to the PGRMO input sentence:

1. If the target sentence mode is ‘2’ (disable all), ‘3’ (enable all), or ‘4’ (restore defaults), the target
sentence description is not checked for validity. In this case, an empty field is allowed (e.g.,
$PGRMO,,3), or the mode field may contain from 1 to 5 characters.

2. If the target sentence mode is ‘0’ (disable) or ‘1’ (enable), the target sentence description field must be
an identifier for one of the sentences that can be output by the GPS sensor.

3. If either the target sentence mode field or the target sentence description field is not valid, the PGRMO
sentence will have no effect.

4. $PGRMO,GPALM,1 causes the GPS sensor to transmit all stored almanac information. All other
NMEA 0183 sentence transmission is temporarily suspended.

5. $PGRMO,,G causes the COM 1 port to change to Garmin Data Transfer format for the duration of the
power cycle. The Garmin mode is required for GPS 15H & 15L product software updates.
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4.1.6 Tune DGPS Beacon Receiver (PSLIB)
The $PSLIB sentence provides the ability to tune a Garmin GBR 21, GBR 23 or equivalent beacon
receiver.

$PSLIB,<1>,<2>*hh<CR><LF>

<1> Beacon tune frequency, 0.0, 283.5 – 325.0 kHz in 0.5 kHz steps
<2> Beacon bit rate, 0, 25, 50, 100, or 200 bps

If valid data is received, the GPS sensor stores it in the EEPROM and echoes the PSLIB command to the
beacon receiver. If the GPS sensor is using any stored beacon frequency other than 0.0, it will tune the
beacon receiver once immediately after power up or external reset.
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4.2 TRANSMITTED NMEA 0183 SENTENCES
The subsequent paragraphs define the sentences that can be transmitted on COM 1 by the GPS sensor.

4.2.1 Sentence Transmission Rate
Sentences are transmitted with respect to the user selected baud rate.

Regardless of the selected baud rate, the information transmitted by the GPS sensor is referenced to the
one-pulse-per-second output pulse immediately preceding the GPRMC sentence, or whichever sentence is
output first in the burst (see Table 3 below).

The GPS sensor transmits each sentence (except where noted in particular transmitted sentence
descriptions) at a periodic rate based on the user selected baud rate and user selected output sentences. The
GPS sensor transmits the selected sentences contiguously. The contiguous transmission starts at a GPS
second boundary. Determine the length of the transmission with the following equation and Tables 3 and 4:

total characters to be transmitted
length of transmission =            ---------------------------------------------

characters transmitted per second

Sentence Output by Default? Maximum Characters
GPRMC ✔ 74
GPGGA ✔ 82
GPGSA ✔ 66
GPGSV ✔ 70
PGRME ✔ 35
GPGLL 44
GPVTG 42
PGRMV 32
PGRMF 82
PGRMB ✔ 40
PGRMM ✔ 32
PGRMT Once per minute 50

Table 3: NMEA 0183 Output Sentence Order and Size

Baud Characters per Second
300 30
600 60
1200 120
2400 240
4800 480
9600 960

19200 1920
38400 3840

Table 4: Characters per Second for Available Baud Rates

The maximum number of fields allowed in a single sentence is 82 characters including delimiters. Values
in the table include the sentence start delimiter character “$” and the termination delimiter <CR><LF>. The
factory set defaults result in a once per second transmission at the NMEA 0183 specification transmission
rate of 4800 baud.
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4.2.2 Transmitted Time
The GPS sensor outputs UTC (Coordinated Universal Time) date and time of day in the transmitted
sentences. Before the initial position fix, the on-board clock provides the date and time of day. After the
initial position fix, the date and time of day are calculated using GPS satellite information and are
synchronized with the one-pulse-per-second output.

The GPS sensor uses information obtained from the GPS satellites to add or delete UTC leap seconds and
correct the transmitted date and time of day. The transmitted date and time of day for leap second
correction follow the guidelines in “National Institute of Standards and Technology Special Publication
432 (Revised 1990)” (for sale by the Superintendent of Documents, U.S. Government Printing Office,
Washington, D.C., 20402, U.S.A.).

When a positive leap second is required, one second is inserted at the beginning of the first hour (0h 0m 0s)
of the day that the positive leap is occurring. The minute containing the leap second is 61 seconds long. The
GPS sensor would have transmitted this information for the leap second added December 31, 1998 as
follows:

$GPRMC,235959,A,3851.3651,N,09447.9382,W,000.0,221.9,071103,003.3,E*69

$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67

$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67

$GPRMC,000001,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*66

If a negative leap second should be required, one second is deleted at the end of some UTC month. The
minute containing the leap second will be only 59 seconds long. In this case, the GPS sensor will not
transmit the time of day 0h 0m 0s (the “zero” second) for the day from which the leap second is removed.

$GPRMC,235959,A,3851.3650,N,09447.9373,W,000.0,000.0,111103,003.3,E*69

$GPRMC,000001,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*6A

$GPRMC,000002,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*69

4.2.3 Global Positioning System Almanac Data (ALM)
Almanac sentences are not normally transmitted. Almanac transmission can be initiated by sending the
GPS sensor a $PGRMO,GPALM,1 command. Upon receipt of this command, the GPS sensor transmits
available almanac information on GPALM sentences. During the transmission of almanac sentences, other
NMEA 0183 data output is temporarily suspended.

$GPALM,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF>

<field information> can be found in Section 4.1.1.

4.2.4 Global Positioning System Fix Data (GGA)
$GPGGA,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,M,<10>,M,<11>,<12>*hh<CR><LF>

<1> UTC time of position fix, hhmmss format
<2> Latitude, ddmm.mmmm format (leading zeros are transmitted)
<3> Latitude hemisphere, N or S
<4> Longitude, dddmm.mmmm format (leading zeros are transmitted)
<5> Longitude hemisphere, E or W
<6> GPS quality indication, 0 = fix not available, 1 = Non-differential GPS fix available,
<7> Number of satellites in use, 00 to 12 (leading zeros are transmitted)
<8> Horizontal dilution of precision, 0.5 to 99.9
<9> Antenna height above/below mean sea level, -9999.9 to 99999.9 meters

<10> Geoidal height, -999.9 to 9999.9 meters
<11> Differential GPS (RTCM SC-104) data age, number of seconds since last valid RTCM

transmission (null if not an RTCM DGPS fix)
<12> Differential Reference Station ID, 0000 to 1023 (leading zeros are transmitted, null if not an

RTCM DGPS fix)



190-00266-01 GPS 15H & 15L Technical Specifications Rev. B
Page 17

4.2.5 GPS DOP and Active Satellites (GSA)
$GPGSA,<1>,<2>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<4>,<5>,<6>*hh<CR><LF>

<1> Mode, M = manual, A = automatic
<2> Fix type, 1 = not available, 2 = 2D, 3 = 3D
<3> PRN number, 01 to 32, of satellite used in solution, up to 12 transmitted (leading zeros are

transmitted)
<4> Position dilution of precision, 0.5 to 99.9
<5> Horizontal dilution of precision, 0.5 to 99.9
<6> Vertical dilution of precision, 0.5 to 99.9

4.2.6 GPS Satellites in View (GSV)
$GPGSV,<1>,<2>,<3>,<4>,<5>,<6>,<7>,...<4>,<5>,<6>,<7>*hh<CR><LF>

<1> Total number of GSV sentences to be transmitted
<2> Number of current GSV sentence
<3> Total number of satellites in view, 00 to 12 (leading zeros are transmitted)
<4> Satellite PRN number, 01 to 32 (leading zeros are transmitted)
<5> Satellite elevation, 00 to 90 degrees (leading zeros are transmitted)
<6> Satellite azimuth, 000 to 359 degrees, true (leading zeros are transmitted)
<7> Signal to noise ratio (C/No) 00 to 99 dB, null when not tracking (leading zeros are transmitted)

NOTE:  Items <4>,<5>,<6>, and <7> repeat for each satellite in view to a maximum of four (4) satellites
per sentence. Additional satellites in view information must be sent in subsequent bursts of NMEA 0183
data. These fields will be null if unused.

4.2.7 Recommended Minimum Specific GPS/TRANSIT Data (RMC)
$GPRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh<CR><LF>

<1> UTC time of position fix, hhmmss format
<2> Status, A = Valid position, V = NAV receiver warning
<3> Latitude, ddmm.mmmm format (leading zeros are transmitted)
<4> Latitude hemisphere, N or S
<5> Longitude, dddmm.mmmm format (leading zeros are transmitted)
<6> Longitude hemisphere, E or W
<7> Speed over ground, 000.0 to 999.9 knots (leading zeros are transmitted)
<8> Course over ground, 000.0 to 359.9 degrees, true (leading zeros are transmitted)
<9> UTC date of position fix, ddmmyy format

<10> Magnetic variation, 000.0 to 180.0 degrees (leading zeros are transmitted)
<11> Magnetic variation direction, E or W (westerly variation adds to true course)

4.2.8 Track Made Good and Ground Speed (VTG)
$GPVTG,<1>,T,<2>,M,<3>,N,<4>,K,<5>*hh<CR><LF>

<1> True course over ground, 000 to 359 degrees (leading zeros are transmitted)
<2> Magnetic course over ground, 000 to 359 degrees (leading zeros are transmitted)
<3> Speed over ground, 000.0 to 999.9 knots (leading zeros are transmitted)
<4> Speed over ground, 0000.0 to 1851.8 kilometers per hour (leading zeros are transmitted)
<5> Mode indicator (only output if NMEA 0183 version 3.00 active), A = Autonomous,

D = Differential, E = Estimated, N = Data not valid
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4.2.9 Geographic Position (GLL)
$GPGLL,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF>

<1> Latitude, ddmm.mmmm format (leading zeros are transmitted)
<2> Latitude hemisphere, N or S
<3> Longitude, dddmm.mmmm format (leading zeros are transmitted)
<4> Longitude hemisphere, E or W
<5> UTC time of position fix, hhmmss format
<6> Status, A = Valid position, V = NAV receiver warning
<7> Mode indicator (only output if NMEA 0183 version 3.00 active), A = Autonomous,

D = Differential, E = Estimated, N = Data not valid

4.2.10 Estimated Error Information (PGRME)
$PGRME,<1>,M,<2>,M,<3>,M*hh<CR><LF>

<1> Estimated horizontal position error (HPE), 0.0 to 999.9 meters
<2> Estimated vertical position error (VPE), 0.0 to 999.9 meters
<3> Estimated position error (EPE), 0.0 to 999.9 meters

4.2.11 GPS Fix Data Sentence (PGRMF)
$PGRMF,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF>

<1> GPS week number (0 - 1023)
<2> GPS seconds (0 - 604799)
<3> UTC date of position fix, ddmmyy format
<4> UTC time of position fix, hhmmss format
<5> GPS leap second count
<6> Latitude, ddmm.mmmm format (leading zeros are transmitted)
<7> Latitude hemisphere, N or S
<8> Longitude, dddmm.mmmm format (leading zeros are transmitted)
<9> Longitude hemisphere, E or W

<10> Mode, M = manual, A = automatic
<11> Fix type, 0 = no fix, 1 = 2D fix, 2 = 3D fix
<12> Speed over ground, 0 to 1851 kilometers/hour
<13> Course over ground, 0 to 359 degrees, true
<14> Position dilution of precision, 0 to 9 (rounded to nearest integer value)
<15> Time dilution of precision, 0 to 9 (rounded to nearest integer value)

4.2.12 Map Datum (PGRMM)
The Garmin Proprietary sentence $PGRMM gives the name of the map datum currently in use by the GPS
sensor. This information is used by the Garmin MapSource real-time plotting application.

$PGRMM,<1>*hh<CR><LF>

<1> Name of map datum currently in use (variable length field, e.g., “WGS 84”)
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4.2.13 Sensor Status Information (PGRMT)
The GARMIN Proprietary sentence $PGRMT gives information concerning the status of the GPS sensor.
This sentence is transmitted once per minute regardless of the selected baud rate.

$PGRMT,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>*hh<CR><LF>

<1> Product, model and software version (variable length field, e.g., “GPS 15H & 15L VER
2.05”)

<2> ROM checksum test, P = pass, F = fail
<3> Receiver failure discrete, P = pass, F = fail
<4> Stored data lost, R = retained, L = lost
<5> Real time clock lost, R = retained, L = lost
<6> Oscillator drift discrete, P = pass, F = excessive drift detected
<7> Data collection discrete, C = collecting, null if not collecting
<8> GPS sensor temperature in degrees C
<9> GPS sensor configuration data, R = retained, L = lost

4.2.14 3D velocity Information (PGRMV)
$PGRMV,<1>,<2>,<3>*hh<CR><LF>

<1> True east velocity, -514.4 to 514.4 meters/second
<2> True north velocity, -514.4 to 514.4 meters/second
<3> Up velocity, -999.9 to 9999.9 meters/second

4.2.15 DGPS Beacon Information (PGRMB)
$PGRMB,<1>,<2>,<3>,<4>,<5>,K,<6>,<7>*hh<CR><LF>

<1> Beacon tune frequency, 0.0, 283.5 – 325.0 kHz in 0.5 kHz steps
<2> Beacon bit rate, 0, 25, 50, 100, or 200 bps
<3> Beacon SNR, 0 to 31
<4> Beacon data quality, 0 to 100
<5> Distance to beacon reference station in kilometers
<6> Beacon receiver communication status (0 = Check Wiring, 1 = No Signal, 2 = Tuning, 3 =

Receiving, 4= Scanning)
<7> DGPS fix source (R = RTCM, W = WAAS, N = Non-DGPS Fix)
<8> DGPS mode, A = Automatic, W = WAAS Only, R = RTCM Only, N = None (DGPS

disabled)



190-00266-01 GPS 15H & 15L Technical Specifications Rev. B
Page 20

4.3 BAUD RATE SELECTION
Baud rate selection can be performed by sending the appropriate configuration sentence to the GPS sensor
as described in the $PGRMC Section 4.1.3, field <10>.

4.4 ONE-PULSE-PER-SECOND (PPS) OUTPUT
The highly accurate one-pulse-per-second (PPS) output is provided for applications requiring precise
timing measurements. The signal is generated after the initial position fix has been calculated and continues
until power down. The rising edge of the signal is synchronized to the start of each GPS second.

Regardless of the selected baud rate, the information transmitted by the GPS 15H & 15L is referenced to
the pulse immediately preceding the NMEA 0183 RMC sentence.

The accuracy of the one-pulse-per-second output is maintained only while the GPS 15H & 15L can
compute a valid position fix. To obtain the most accurate results, the one-pulse-per-second output should be
calibrated against a local time reference to compensate for cable and internal receiver delays and the local
time bias.

The default pulse width is 100 ms, however; it may be programmed in 20 ms increments between 20 ms
and 980 ms as described in $PGRMC Section 4.1.3, field <13>.

4.5 RECEIVED RTCM DATA
Position accuracy of less than 5 meters can be achieved with the GPS 15H & 15L by using Differential
GPS (DGPS) real-time pseudo-range correction data in RTCM SC-104 format, with message types 1, 2, 3,
7, and 9. These corrections can be received by the GPS 15H & 15L on COM 2. The RTCM data must be
received at the same baud rate as the COM 1 port. For details on the SC-104 format, refer to RTCM Paper
134-89/SC 104-68 by the Radio Technical Commission for Maritime Services.
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APPENDIX A: EARTH DATUMS

The following is a list of the Garmin GPS 15H & 15L Earth datum indices and the corresponding earth
datum name (including the area of application):

0 ADINDAN - Ethiopia, Mali, Senegal, Sudan

1 AFGOOYE - Somalia

2 AIN EL ABD 1970 - Bahrain Island, Saudi Arabia

3 ANNA 1 ASTRO 1965 - Cocos Island

4 ARC 1950 - Botswana, Lesotho, Malawi, Swaziland, Zaire, Zambia, Zimbabwe

5 ARC 1960 - Kenya, Tanzania

6 ASCENSION ISLAND 1958 - Ascension Island

7 ASTRO BEACON “E” - Iwo Jima Island

8 AUSTRALIAN GEODETIC 1966 - Australia, Tasmania Island

9 AUSTRALIAN GEODETIC 1984 - Australia, Tasmania Island

10 ASTRO DOS 71/4 - St. Helena Island

11 ASTRONOMIC STATION 1952 - Marcus Island

12 ASTRO B4 SOROL ATOLL - Tern Island

13 BELLEVUE (IGN) - Efate and Erromango Islands

14 BERMUDA 1957 - Bermuda Islands

15 BOGOTA OBSERVATORY - Colombia

16 CAMPO INCHAUSPE - Argentina

17 CANTON ASTRO 1966 - Phoenix Islands

18 CAPE CANAVERAL - Florida, Bahama Islands

19 CAPE - South Africa

20 CARTHAGE - Tunisia

21 CHATHAM 1971 - Chatham Island (New Zealand)

22 CHUA ASTRO - Paraguay

23 CORREGO ALEGRE - Brazil

24 DJAKARTA (BATAVIA) - Sumatra Island (Indonesia)

25 DOS 1968 - Gizo Island (New Georgia Islands)

26 EASTER ISLAND 1967 - Easter Island

27 EUROPEAN 1950 - Austria, Belgium, Denmark, Finland, France, Germany, Gibraltar, Greece,
Italy, Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland

28 EUROPEAN 1979 - Austria, Finland, Netherlands, Norway, Spain, Sweden, Switzerland

29 FINLAND HAYFORD 1910 - Finland

30 GANDAJIKA BASE - Republic of Maldives

31 GEODETIC DATUM 1949 - New Zealand

32 ORDNANCE SURVEY OF GREAT BRITAIN 1936 - England, Isle of Man, Scotland,
Shetland Islands, Wales

33 GUAM 1963 - Guam Island

34 GUX 1 ASTRO - Guadalcanal Island

35 HJORSEY 1955 - Iceland
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36 HONG KONG 1963 - Hong Kong

37 INDIAN - Bangladesh, India, Nepal

38 INDIAN - Thailand, Vietnam

39 IRELAND 1965 - Ireland

40 ISTS O73 ASTRO 1969 - Diego Garcia

41 JOHNSTON ISLAND 1961 - Johnston Island

42 KANDAWALA - Sri Lanka

43 KERGUELEN ISLAND - Kerguelen Island

44 KERTAU 1948 - West Malaysia, Singapore

45 L.C. 5 ASTRO - Cayman Brac Island

46 LIBERIA 1964 - Liberia

47 LUZON - Mindanao Island

48 LUZON - Phillippines (excluding Mindanao Island)

49 MAHE 1971 - Mahe Island

50 MARCO ASTRO - Salvage Islands

51 MASSAWA - Eritrea (Ethiopia)

52 MERCHICH - Morocco

53 MIDWAY ASTRO 1961 - Midway Island

54 MINNA - Nigeria

55 NORTH AMERICAN 1927 - Alaska

56 NORTH AMERICAN 1927 - Bahamas (excluding San Salvador Island)

57 NORTH AMERICAN 1927 - Central America (Belize, Costa Rica, El Salvador, Guatemala,
Honduras, Nicaragua)

58 NORTH AMERICAN 1927 - Canal Zone

59 NORTH AMERICAN 1927 - Canada (including Newfoundland Island)

60 NORTH AMERICAN 1927 - Caribbean (Barbados, Caicos Islands, Cuba, Dominican
Republic, Grand Cayman, Jamaica, Leeward Islands, Turks Islands)

61 NORTH AMERICAN 1927 - Mean Value (CONUS)

62 NORTH AMERICAN 1927 - Cuba

63 NORTH AMERICAN 1927 - Greenland (Hayes Peninsula)

64 NORTH AMERICAN 1927 - Mexico

65 NORTH AMERICAN 1927 - San Salvador Island

66 NORTH AMERICAN 1983 - Alaska, Canada, Central America, CONUS, Mexico

67 NAPARIMA, BWI - Trinidad and Tobago

68 NAHRWAN - Masirah Island (Oman)

69 NAHRWAN - Saudi Arabia

70 NAHRWAN - United Arab Emirates

71 OBSERVATORIO 1966 - Corvo and Flores Islands (Azores)

72 OLD EGYPTIAN - Egypt

73 OLD HAWAIIAN - Mean Value

74 OMAN - Oman
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75 PICO DE LAS NIEVES - Canary Islands

76 PITCAIRN ASTRO 1967 - Pitcairn Island

77 PUERTO RICO - Puerto Rico, Virgin Islands

78 QATAR NATIONAL - Qatar

79 QORNOQ - South Greenland

80 REUNION - Mascarene Island

81 ROME 1940 - Sardinia Island

82 RT 90 - Sweden

83 PROVISIONAL SOUTH AMERICAN 1956 - Bolivia, Chile, Colombia, Ecuador, Guyana,
Peru, Venezuela

84 SOUTH AMERICAN 1969 - Argentina, Bolivia, Brazil, Chile, Colombia, Ecuador, Guyana,
Paraguay, Peru, Venezuela, Trinidad and Tobago

85 SOUTH ASIA - Singapore

86 PROVISIONAL SOUTH CHILEAN 1963 - South Chile

87 SANTO (DOS) - Espirito Santo Island

88 SAO BRAZ - Sao Miguel, Santa Maria Islands (Azores)

89 SAPPER HILL 1943 - East Falkland Island

90 SCHWARZECK - Namibia

91 SOUTHEAST BASE - Porto Santo and Madeira Islands

92 SOUTHWEST BASE - Faial, Graciosa, Pico, Sao Jorge, and Terceira Islands (Azores)

93 TIMBALAI 1948 - Brunei and East Malaysia (Sarawak and Sabah)

94 TOKYO - Japan, Korea, Okinawa

95 TRISTAN ASTRO 1968 - Tristan da Cunha

96 User defined earth datum

97 VITI LEVU 1916 - Viti Levu Island (Fiji Islands)

98 WAKE-ENIWETOK 1960 - Marshall Islands

99 WORLD GEODETIC SYSTEM 1972

100 WORLD GEODETIC SYSTEM 1984

101 ZANDERIJ - Surinam

102 CH-1903 - Switzerland

103 Hu - Tzu - Shan

104 Indonesia 74

105 Austria

106 Potsdam

107 Taiwan - modified Hu-Tzu-Shan

108 GDA - Geocentric Datum of Australia

109 Dutch
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APPENDIX B: BINARY PHASE OUTPUT FORMAT

In binary phase output mode, GPS 15H & 15L series products transmit two types of packets once per
second. One record contains primarily post-process information such as position and velocity information.
The second record contains receiver measurement information. For the GPS 15H & 15L, the records are
sent at a default baud rate of 9600 baud, 8 data bits, and no parity.

To turn these records on, use the $PGRMC1 NMEA sentence as described in Section 4 GPS 15H & 15L
Software Interface. (Refer to the GARMIN GPS Interface Specification for details on how to form and parse
Garmin packets. At the time of this printing, these specs are available from the technical support section of
our Web site: http://www.garmin.com/support/commProtocol.html.)

Note that the satellite data information is also enabled when the position record is enabled.

Records sent over RS232 begin with a delimiter byte (10 hex). The second byte identifies the record type
(33 hex for a position record and 34 hex for a receiver measurement). The third byte indicates the size of
the data. The fourth byte is the first byte of data. The data is then followed by a checksum byte, a delimiter
byte (10 hex), and an end-of-transmission character (03 hex). Additionally, any DLEs (0x10) that appear
between the delimeters are escaped with a second DLE. There is sample code at the end of this section that
strips off the DLEs and ETXs.

RS232 Packet:

- 0x10 (DLE is first byte)

- 0x## (Record ID – single byte)

- 0x## (Number of data bytes – single byte)

- data bytes (See descriptions below)

- 0x## (2’s complement of the arithmetic sum of the bytes between the delimiters)

- 0x10 (DLE)

- 0x03 (ETX is last byte)

The data bytes of each packet contain the record specified by the record ID. A description of each record
follows.

Position Record
The Position Record has a record identifier of
typedef struct

{
float alt;
float epe;
float eph;
float epv;
int fix;
double gps_tow;
double lat;
double lon;
float lon_vel;
float lat_vel;
float alt_vel;
float msl_hght;
int leap_sec;
long grmn_days;
} cpo_pvt_data;

alt Ellipsoid altitude (meters)
epe Est pos error (meters)
eph Pos err, horizontal (meters)
epv Pos err, vertical (meters)
fix 0 = no fix; 1 = no fix; 2 = 2D; 3 = 3D; 4 = 2D differential; 5 = 3D differential;

6 and greater - not defined

http://www.garmin.com/support/commProtocol.html
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gps_tow GPS time of week (sec)
lat Latitude (radians)
lon Longitude (radians)
lon_vel Longitude velocity (meters/second)
lat_vel Latitude velocity (meters/second)
alt_vel Altitude velocity (meters/second)
msl_hght Mean sea level height (meters)
leap_sec UTC leap seconds
grmn_days Garmin days (days since December 31, 1989)

Receiver Measurement Record
typedef struct
    {
    unsigned long cycles;
    double pr;
    unsigned int phase;
    char slp_dtct;
    unsigned char snr_dbhz;
    char svid;
    char valid;
} cpo_rcv_sv_data;

typedef struct
    {
    double rcvr_tow;
    int rcvr_wn;
    cpo_rcv_sv_data sv[ 12 ];
} cpo_rcv_data;

rcvr_tow Receiver time of week (seconds)
rcvr_wn Receiver week number
cycles Number of  accumulated cycles
pr Pseudorange (meters)
phase To convert to (0 -359.999) multiply by 360.0 and divide by 2048.0
slp_dtct 0 = no cycle slip detected; non-zero = cycle slip detected
snr_dbhz Signal strength - db Hz
svid Satellite number (0-31 and 119-138 for WAAS)  Note: Add 1 to offset to current svid

numbers.
valid 0 = information not valid; non-zero = information valid
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Sample C Code
DLE and ETX bytes:
Sample C code to receive the two records should filter DLE and ETX bytes as described below:
typedef enum
    {
    DAT,
    DLE,
    ETX
    } rx_state_type;

/* Declare and initialize static variables */
static char in_que[ 256 ];
static int in_que_ptr = 0;
static rx_state_type rx_state = DAT;

.

.

.

void add_to_que( char data )
{
#define DLE_BYTE 0x10
#define ETX_BYTE 0x03

if ( rx_state == DAT )
    {
    if ( data == DLE_BYTE )
        {
        rx_state = DLE;
        }
    else
        {
        in_que[ in_que_ptr++ ] = data;
        }
    }
else if ( rx_state == DLE )
    {
    if ( data == ETX_BYTE )
        {
        rx_state = ETX;
        }
    else
        {
        rx_state = DAT;
        in_que[ in_que_ptr++ ] = data;
        }
    }
else if ( rx_state == ETX )
    {
    if ( data == DLE_BYTE )
        {
        rx_state = DLE;
        }
    }

if ( in_que_ptr > 255 )
    {
    in_que_ptr = 0;
    }
}
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APPENDIX C: EPHEMERIS DATA DOWNLOAD (PROGRAMMING EXAMPLE)

Synopsis
This section describes, using an example, how to download ephemeris information from a Garmin 15, 16,
17 or 18 family GPS unit with the exception of the GPS 15-W and the GPS 15-F.

Garmin Binary Format Review
In order to download the ephemeris data, you must first command the unit to output information in Garmin
Binary Format (Garmin mode) instead of the default NMEA output format. To put the unit in Garmin
mode, connect to the unit using a terminal program and send the following NMEA sentence:
$PGRMO,,G*hh<CR><LF>

The checksum *hh is used for parity checking data and is not required, but is recommended for use in
environments containing high electromagnetic noise. It is generally not required in normal PC
environments. When used, the parity bytes (hh) are the ASCII representation of the exclusive-or (XOR)
sum of all the characters between the "$” and “*” characters, non-inclusive. Sentences may be truncated by
<CR><LF> after any data field and valid fields up to that point are acted on by the GPS sensor. The unit
stays in Garmin mode until the next power cycle.

Now that unit is in Garmin binary format, transmitted and received packets are structured as follows:

Byte Description Name Notes
Packet Delimiter DLE 0x10
Packet ID (type) ID Packet type
Data Size SIZE Number of bytes in data portion(not

including escaped DLEs. See below)
Data bytes DATA Not to exceed 256 bytes
. . .
. . .
. . .
Checksum                CHKSUM 2’s complement of the arithmetic

sum of all the bytes from the
Packet ID byte to the last DATA
byte(inclusive) not counting
escaped DLEs. See below

Packet Delimiter DLE 0x10
End of Packet ETX 0x03

The DLE (0x10) is a delimiter byte used in conjunction with the ETX byte to determine beginning and
ending of a packet. However, a 0x10 could appear in the data itself, so if this occurs the byte is escaped
with another DLE byte (sometimes referred to as DLE stuffing). In other words, if a DLE occurs in the
data, another DLE is transmitted immediately after to indicate that it is a data byte and it is not being used
as a delimiter. Note that the size byte of the packet does not count the second DLE byte in an escaped DLE
pair in the data field. Since a DLE that is a part of the data will have a second DLE to escape it, a single
DLE followed by an ETX byte means that the end of a packet has been reached.

In order to interpret these packets properly, one must remove the escaped DLE bytes. This can be achieved
using an algorithm similar to the Sample C Code fragment on the previous page.
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Ephemeris Download Procedure
The following is the sequence of events that occurs when downloading ephemeris data.

Send a packet containing the command that requests ephemeris data (IOP_DOWN_LOAD_EPH). The
packet should look like this:

TX Packet: Ephemeris Data Request

Byte Description Name HEX Value
Delimiter DLE 0x10
Command Data ID IOP_CMND_DATA 0x0A
Number of bytes in data SIZE 0x02
Request to D/L ephemeris IOP_DOWN_LOAD_EPH 0x5D
Pad to 2 bytes DATA 0x00
Checksum calculation CHKSUM 0x97*
Delimiter DLE 0x10
End ETX 0x03
* From now on, checksum calculation will not be shown for every packet example

The unit returns an acknowledgement packet that looks like this:

RX Packet: Acknowledgement

Byte Description Name HEX Value
Delimiter DLE 0x10
Acknowledgement ID IOP_ACK_BYTE 0x06
Number of bytes in data SIZE 0x02
Request to D/L ephemeris IOP_CMND_DATA 0x0A
Pad DATA 0x00
Checksum calculation CHKSUM ----
Delimiter DLE 0x10
End of packet ETX 0x03

Then, the unit immediately sends a packet communicating how many data packets to expect for the
ephemeris download (a maximum of twelve):

RX Packet: Number of Data Packets to Expect

Byte Description Name HEX Value
Delimiter DLE 0x10
Record ID IOP_RECORDS 0x1B
Number of bytes in data SIZE 0x02
Number of records NUM_SV 0x0C
Pad DATA 0x00
Checksum calculation CHKSUM ----
Delimiter DLE 0x10
End of packet ETX 0x03

This packet requires acknowledgement, as shown below (note that the data field contains the
IOP_RECORDS ID to indicate the acknowledgement of the IOP_RECORDS packet):

TX Packet: Acknowledgement

Byte Description Name HEX Value
Delimiter DLE 0x10
Record ID IOP_ACK_BYTE 0x06
Number of bytes in data SIZE 0x02
Pad DATA 0x00
ID of packet being ACK’d IOP_RECORDS 0x1B
Checksum calculation CHKSUM ----
Delimiter DLE 0x10
End of packet ETX 0x03
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Next, the unit sends the specified number of packets containing the ephemeris information. An example
packet is shown below. Each packet should be acknowledged as before (be sure to modify the ACK packet
to indicate what type of packet being acknowledged—for ephemeris data the ID is 0x35).

RX Packet: Ephemeris Data

Byte Description Name HEX Value
Delimiter DLE 0x10
Ephemeris data ID IOP_SPC_EPH_DATA 0x35
Number of bytes in data SIZE 0x78
Ephemeris data DATA ----
. . .
. . .
. . .
Checksum calculation CHKSUM ----
Delimiter DLE 0x10
End of packet ETX 0x03

The data portion of each packet can then be parsed into an instance of the following structure. Each of these
structures represents data from a single satellite.

typedef struct  /* ephemeris data record for SPC */
{
sint16  wn; /* week number (weeks) */
float   toc;    /* reference time of clock parameters (s) */
float   toe;    /* reference time of ephemeris parameters (s) */
float   af0;    /* clock correction coefficient - group delay   (s) */
float   af1;    /* clock correction coefficient           (s/s) */
float   af2;    /* clock correction coefficient         (s/s/s) */
float   ura;    /* user range accuracy                      (m) */
double  e;      /* eccentricity                             (-) */
double  sqrta;  /* square root of semi-major axis (a)  (m**1/2) */
double  dn;     /* mean motion correction                 (r/s) */
double  m0;     /* mean anomaly at reference time           (r) */
double  w;      /* argument of perigee                      (r) */
double  omg0;   /* right ascension                          (r) */
double  i0;     /* inclination angle at reference time      (r) */
float   odot;   /* rate of right ascension                (r/s) */
float   idot;   /* rate of inclination angle              (r/s) */
float   cus;    /* argument of latitude correction, sine    (r) */
float   cuc;    /* argument of latitude correction, cosine  (r) */
float   cis;    /* inclination correction, sine             (r) */
float   cic;    /* inclination correction, cosine           (r) */
float   crs;    /* radius correction, sine                  (m) */
float   crc;    /* radius correction, cosine                (m) */
unsigned char  iod; /* issue of data */
} SDM_spc_eph_type;
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An example function to complete the parsing is shown below. Note that the double data types are converted
by the function cnvt_ieee_double(). This function merely swaps the upper and lower words of the
double. This is necessary on GPS 15, 16, 17 series sensors due to a compatibility issue with the IEEE
floating point standard): In this example, the array m_TempArray contains the data portion of the
ephemeris packet (with DLE stuffing removed).
/****************************************************************************
*
*   PROCEDURE NAME:
* copyData - ephemeris data unpacker
*
*   DESCRIPTION:
* unpacks data from ephemeris packet DATA field after extraneous DLEs
* have been removed. Note that sint16 refers to a signed 16-bit
* integer type.
*
****************************************************************************/
void GPM_ephList::copyData /* ephemeris data unpacker */

(
GPM_ephData* pTemp /* pointer to ephemeris data array */
)

{
pTemp->EphStruct.wn  = *(sint16*)&m_TempArray[IDX_EPH_WN];
pTemp->EphStruct.toc = *(float*)&m_TempArray[IDX_EPH_TOC];
pTemp->EphStruct.toe = *(float*)&m_TempArray[IDX_EPH_TOE];
pTemp->EphStruct.af0 = *(float*)&m_TempArray[IDX_EPH_AF0];
pTemp->EphStruct.af1 = *(float*)&m_TempArray[IDX_EPH_AF1];
pTemp->EphStruct.af2 = *(float*)&m_TempArray[IDX_EPH_AF2];
pTemp->EphStruct.ura = *(float*)&m_TempArray[IDX_EPH_URA];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_E]);
pTemp->EphStruct.e = *(double*)&m_TempArray[IDX_EPH_E];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_SQRTA]);
pTemp->EphStruct.sqrta = *(double*)&m_TempArray[IDX_EPH_SQRTA];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_DN]);
pTemp->EphStruct.dn = *(double*)&m_TempArray[IDX_EPH_DN];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_M0]);
pTemp->EphStruct.m0 = *(double*)&m_TempArray[IDX_EPH_M0];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_W]);
pTemp->EphStruct.w = *(double*)&m_TempArray[IDX_EPH_W];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_OMG0]);
pTemp->EphStruct.omg0 = *(double*)&m_TempArray[IDX_EPH_OMG0];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_I0]);
pTemp->EphStruct.i0 = *(double*)&m_TempArray[IDX_EPH_I0];

pTemp->EphStruct.odot = *(float*)&m_TempArray[IDX_EPH_ODOT];
pTemp->EphStruct.idot = *(float*)&m_TempArray[IDX_EPH_IDOT];
pTemp->EphStruct.cus = *(float*)&m_TempArray[IDX_EPH_CUS];
pTemp->EphStruct.cuc = *(float*)&m_TempArray[IDX_EPH_CUC];
pTemp->EphStruct.cis = *(float*)&m_TempArray[IDX_EPH_CIS];
pTemp->EphStruct.cic = *(float*)&m_TempArray[IDX_EPH_CIC];
pTemp->EphStruct.crs = *(float*)&m_TempArray[IDX_EPH_CRS];
pTemp->EphStruct.crc = *(float*)&m_TempArray[IDX_EPH_CRC];
pTemp->EphStruct.iod = *(unsigned char*)&m_TempArray[IDX_EPH_IOD];

return;

} /* copyData */
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Each data member of the ephemeris data structure is indexed into the data array of the ephemeris packet
and cast as the appropriate data type. The indices are as follows (note that they correlate to the data
members of the structure respectively):
#define IDX_EPH_WN 0
#define IDX_EPH_TOC 4
#define IDX_EPH_TOE 8
#define IDX_EPH_AF0 12
#define IDX_EPH_AF1 16
#define IDX_EPH_AF2 20
#define IDX_EPH_URA 24
#define IDX_EPH_E 28
#define IDX_EPH_SQRTA 36
#define IDX_EPH_DN 44
#define IDX_EPH_M0 52
#define IDX_EPH_W 60
#define IDX_EPH_OMG0 68
#define IDX_EPH_I0 76
#define IDX_EPH_ODOT 84
#define IDX_EPH_IDOT 88
#define IDX_EPH_CUS 92
#define IDX_EPH_CUC 96
#define IDX_EPH_CIS 100
#define IDX_EPH_CIC 104
#define IDX_EPH_CRS 108
#define IDX_EPH_CRC 112
#define IDX_EPH_IOD 116

The last packet is a “download complete” packet that looks like this:

TX Packet: Download Complete

Byte Description Name HEX Value
Delimiter DLE 0x10
Download Complete ID IOP_DL_CMPLT 0x0c
Number of bytes in data SIZE 0x02
Ephemeris Download ID IOP_DOWN_LOAD_EPH 0x5D
Pad DATA 0x00
Checksum calculation CHKSUM ----
Delimiter DLE 0x10
End of packet ETX 0x03

After properly acknowledging this packet (ACK the IOP_DL_CMPLT ID), the ephemeris download is
complete.
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APPENDIX D: SENSOR CONFIGURATION SOFTWARE

SNSRCFG configures the GPS sensors based on user-selected parameters. Some application features
include the ability to download GPS sensor configuration, maintain different configurations in files, and
perform GPS sensor configurations quickly with the use of one function key.

This section provides a brief overview of the Sensor Configuration Software. Refer to this section when
using the software to configure your Garmin sensor.

Downloading the Sensor Configuration Software
The Garmin Sensor Configuration Software (SNSRCFG.exe) is
available from the Garmin Web site. To download the software, start
at http://www.garmin.com/oem, select the GPS 15H/15L, and then
select Software Updates. The Garmin Sensor Configuration Software
(SNSRCFG.exe) is included in the software update download.

Selecting a Model
After opening the program (snsrcfg.exe), the following screen
appears. Select the radio button next to the type of Garmin sensor you
are configuring.

Connecting to the Sensor
After selecting the type of sensor, the following window opens. This is
the Main Interface Screen for the program.

To configure your sensor, you must first connect to the sensor.

1. Select Config > Switch to NMEA Mode (or press the F10 key).
2. Select Comm > Setup to open the Comm Setup Window.
3. Select the Serial Port to which the sensor is

connected. Select Auto to have the program
automatically determine the Baud Rate, or select
Manual to manually select the Baud Rate of the
GPS 15H & 15L. Click OK when done.

Click the Connect icon , or select Comm >
Connect.
To view the current programming of the sensor, select
Config > Get Configuration from GPS (or press the
F8 key). The current programming of the sensor is
displayed in the window shown to the right.

File Menu
The File Menu allows you to open, save, and print
sensor configurations. The items in the File Menu work
like most Windows-based programs.

http://www.garmin.com/oem
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Comm Menu
The Comm (Communication) Menu allows you to set the port number, baud rate, and then connect and
disconnect from the sensor.

Setup: Opens the Comm Setup Window, shown to the left. Select
the Serial Port to which the sensor is connected from the drop-
down list. Then select Auto (the program determines the baud rate
on its own) or Manual (you then enter the baud rate) for the Baud
Rate entry.

Connect: Select Connect to connect to the sensor to change or
view the configuration.

Disconnect: Select Disconnect to disconnect from the sensor.

Config Menu
The Config (Configuration) Menu allows you
configure the sensor as it is connected.

Sensor Configuration (F6): Opens the Sensor
Configuration Window, shown to the right. Many of
the fields in this window should be left alone. For
the most part, this window is used to enter a new
Latitude, Longitude, and Altitude for the sensor.
This is especially helpful when you are
programming the sensor for use in a particular
geographic location.

Resetting the Unit (Reset Unit) performs a reset on
the unit, much like cycling the power.

Resetting the non-volatile memory (Reset NonVol)
clears all of the data from the non-volatile memory.

NMEA Sentence Selections (F7): Displays the
NMEA Sentence Selections Window. If the
sentence is enabled, a check mark appears in the
box to the left of the sentence name. Click the box
to enable or disable to the sentence.
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Get Configuration From GPS (F8): Retrieves the current programming from the sensor. The
programming is then displayed in the Main Interface Window.

Send Configuration To GPS (F9): Sends the programming changes to the sensor.

Switch to NMEA Mode (F10): Switches the unit to NMEA Mode. The sensor must be in NMEA Mode in
order to establish a serial connection to this software (see “Connecting to the Sensor” above).

Switch to Garmin Mode (F11): Switches the unit to Garmin Mode.

Update Software (F12): Not applicable for the GPS 15H & 15L. After you have downloaded a new
software version for the sensor, you can update the sensor with the new software. Select Update Software
and then select the file using the Open dialog box. You must locate both the *.rgn and updater.exe files.

View Menu
The View Menu allows you to view the NMEA sentences transmitted by the sensor. You can also
customize how the program looks by showing and hiding the Toolbar and Status Bar.

Help Menu
The Help Menu displays the software version and copyright information.
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